KinExA Manual
KinExA 4000, 3X00, & Autosampler
®

Copyright© 2019 Sapidyne Instruments Inc.

UM200R1

Table of Contents

KinExA Theory...........................................................................................................................................................1
Terminology............................................................................................................................................................................................1
Introduction............................................................................................................................................................................................1
Reversible Binding Review......................................................................................................................................................................1
KinExA Binding Curves............................................................................................................................................................................2
Kinetic Exclusion Assay............................................................................................................................................................................2
KinExA Detection Method.................................................................................................................................................................3
Preparing for an Experiment......................................................................................................................................5
Equilibrium Measurements........................................................................................................................................5
Equilibrium Measurement Flow Chart.....................................................................................................................................................5
Determine the Constant Binding Partner (CBP) and Titrant....................................................................................................................6
Equilibrium Timing Setup..........................................................................................................................................7
Preliminary Tests...................................................................................................................................................................................10
CBP Concentration: Signal Test........................................................................................................................................................10
Titrant Concentration: Range Find..................................................................................................................................................11
Equilibrium Experiment........................................................................................................................................................................12
Whole Cell Equilibrium Experiment.......................................................................................................................................................13
Analysis: n-Curve...................................................................................................................................................................................14
Kinetic Measurements.............................................................................................................................................16
Kinetics Direct.......................................................................................................................................................................................16
Whole Cell Kinetics Direct......................................................................................................................................................................19
Kinetics Injection (3X00 Models)...........................................................................................................................................................20
Concentration Measurements..................................................................................................................................22
Concentration Immunoassay Flow Chart...............................................................................................................................................22
Sandwich Assay.....................................................................................................................................................................................22
Inhibition Assay.....................................................................................................................................................................................22
Instrument Overview: KinExA 4000...........................................................................................................................23
Behind the Plumbing Access Panel.......................................................................................................................................................24
Behind the Optics Cover........................................................................................................................................................................25
Instrument Overview: KinExA 3X00...........................................................................................................................26
Behind the Optics Cover........................................................................................................................................................................28
Optics Slide............................................................................................................................................................................................29
Instrument Specifications........................................................................................................................................30
Minimum Requirements..........................................................................................................................................30
Appendix................................................................................................................................................................31
An Introduction to the KinExA Pro® Software........................................................................................................................................31
Categories & Templates.........................................................................................................................................................................32
Useful Icons...........................................................................................................................................................................................33
KinExA Data Analysis.............................................................................................................................................................................38
KinExA Limitations................................................................................................................................................................................43
Copyright© 2019 Sapidyne Instruments Inc.

UM200R1

KinExA Theory
Terminology
kon = Association rate constant, on rate
koff = Dissociation rate constant, off rate
[R] = Free Receptor binding site concentration
[RT] = total Receptor binding site concentration
[L] = Free Ligand binding site concentration
[LT] = Total Ligand binding site concentration

[RL] = Concentration of reversibly bound Receptor-Ligand
complex
K = Equilibrium association constant
Kd = Equilibrium dissociation constant
CBP = Constant Binding Partner
T or Titrant = Titrated binding partner

Introduction
Kinetic Exclusion Assay (KinExA) instruments are designed to measure either [R] or [L] in a mixture of [R], [L], and [RL] complex. One of the binding
partners is held at a constant concentration in all solutions and is referred to as the Constant Binding Partner (CBP) while the other partner is
designated as the Titrant (or T) because its concentration varies. This nomenclature is purposely generic, with CBP and Titrant representing reversible
binding partners (e.g. antibody/antigen, complimentary DNA strands, or protein-protein interactions). The nomenclature is also neutral regarding
the role each molecule plays. For example, when an antibody is measured binding to its antigen, the antibody can take on the role of CBP or Titrant,
depending on experimental convenience.
The free CBP is measured as a function of the Titrant concentration. The data is then analyzed and results in a measured Kd and active concentration
of one of the binding partners.
The KinExA instruments are unique in their ability to measure the free fraction of CBP with high sensitivity and without disturbing the solution
equilibrium. This section reviews binding equations and further describes the Kinetic Exclusion Assay theory.

Reversible Binding Review
In solution, a receptor and its ligand exhibit reversible association and dissociation based on their concentrations and characteristic rate constants
(kon and koff). The following is the reversible equation for receptor and ligand:

Copyright© 2019 Sapidyne Instruments Inc.

Page 1

UM200R1

When the mixture reaches equilibrium the concentrations are no longer changing and the complex association rate is equal to the complex
dissociation rate:

Each receptor-ligand interaction has its own characteristic rate constants. The ratio of the off rate over the on rate, the equilibrium dissociation
constant (Kd), is of particular interest as it provides a way to express the strength of binding in molar units (M):

KinExA Binding Curves
In a KinExA experiment, a series of samples are prepared in which the total concentration of one of the binding partners, either [R] or [L], is kept
constant (CBP) while the total concentration of the other binding partner is titrated (T). A KinExA binding curve plots percent free CBP vs. total
Titrant concentration. The percent free CBP or free fraction is a function of CBPtotal, Ttotal, and Kd:

The equation is given along with an additional description of reversible binding and examples in the Theory Curve (TN220).

Kinetic Exclusion Assay
A Kd analysis requires immobilization of one binding partner (the Titrant) to a solid phase which is then used as a probe to capture the other
interaction partner (CBP). For each equilibrium experiment, samples are prepared such that one of the binding partners is titrated (Titrant) in a
constant background of the other (CBP) and allowed to reach equilibrium. The samples are then briefly exposed to the solid phase and a portion of
the free CBP is captured. This captured CBP is then labeled using a fluorescent secondary molecule (Figure 1). The short contact time with the solid
phase, about 0.5 seconds, is less than the time needed for dissociation of the pre-formed CBP-T complex in solution. Thus, competition between the
solution and the solid phase is “kinetically excluded” and the solution equilibrium is not altered during KinExA experiments.
The signals generated from the captured CBP, which are directly proportional to the concentration of free CBP in the equilibrated samples, are used to
generate a binding curve (percent free CBP vs. total Titrant concentration) when measured in a series. The KinExA Pro software performs a least
squares analysis on the measured data in order to calculate the Kd. When measurements are performed on samples not at equilibrium, kinetic rate
constants can be calculated. A time course display of signal generation is shown in Figure 2.
The KinExA method provides a means to obtain true solution phase measurements. Since the molecules in solution are unmodified, and the
measurement process does not significantly alter solution equilibrium, affinity and kinetic results may more accurately reflect physiological binding
interactions when compared to solid phase methods.
For more information regarding the mathematical theory refer to the Appendix.
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KinExA Detection Method

Figure 1. Illustration of the typical detection method used.

Detection Steps (Figure 1):
1. The Titrant coated solid phase is used to capture a portion of free CBP.
2. Captured CBP is detected with a fluorescently labeled probe (often an anti-tag, or an anti-species secondary antibody).
3. The fluorescent signal is converted to a voltage signal that is directly proportional to the concentration of free CBP in the sample.

Copyright© 2019 Sapidyne Instruments Inc.

Page 3

UM200R1

Figure 2. Time course display of signal as the different solutions are introduced
to the flow cell.

Detection Steps (Figure 2):
1. For each data point, a fresh column of Titrant-coated solid phase is introduced into the flow cell.
2. The equilibrated sample is rapidly drawn through the column where the immobilized Titrant acts as a probe to capture free CBP from the
solution. Voltage measurement begins as sample is introduced. The sample is not typically fluorescent so the voltage signal remains the
same as the baseline.
3. Captured CBP is detected with a fluorescently labeled anti-CBP molecule.
4. Buffer is then run through the flow cell rinsing away unbound label, leaving a voltage signal that is proportional to free CBP in the sample.
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Preparing for an Experiment
Determine which type of measurement is suitable for your objective. There are three types of measurements that can be performed using the KinExA
instrument.

•

Equilibrium measurement: provides information about the equilibrium dissociation constant (Kd) and active concentration of one of
the binding partners.

•

Kinetic measurement: provides information about the association rate constant (kon) and dissociation rate constant (koff).

•

Concentration Immunoassay measurement: determines the concentration of unknown samples.

Equilibrium Measurements
Equilibrium Measurement Flow Chart
Determine Constant Binding Partner (CBP) and
Titrant (pg 6).
Determine the Appropriate Solid Phase & CBP Detection
Solid Phase Selection Guide (TN222)
Labeling Strategies (TN223)
CBP Concentration: Signal Test
Determine the CBP concentration to use for subsequent
experiments (pg 10).
Titrant Range: Range Find
Determine the titration series to use for the Equilibrium
Experiment (pg 11).
Perform an Equilibrium Experiment
Preparation of an Equilibrium Experiment (HG232) (pg 12).
Analysis: n-Curve
Analyze multiple curves on the same axis (pg 14).
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Determine the Constant Binding Partner (CBP) and Titrant
When a receptor and ligand reach equilibrium in solution there are three species present: receptor, ligand, and receptor-ligand complex. The Kinetic
Exclusion Assay (KinExA) measures the free concentration of either the receptor or the ligand without perturbing the equilibrium. Because either
partner can be measured, we refer to the binding partner that will be labeled as the Constant Binding Partner (CBP) and the other as the Titrant for
clarification purposes. The Titrant is both in solution and immobilized to a solid phase. On the solid phase, the Titrant is used to capture free CBP from
the equilibrated solution. A secondary fluorescent label is then used to detect the captured CBP.
Below are things to consider when determining which binding partner should be the CBP or Titrant for equilibrium measurements:

Cost or Convenience
• To minimize cost and material consumption, the more expensive or limiting reagent should be used as the CBP. This is because the CBP is
kept constant at a relatively low concentration, while the Titrant is used at higher concentrations to saturate the CBP and coat the solid
phase.

•

If cost is not an issue, use the format that gives the best signal to noise. For more information regarding signal to noise refer to Signal
Versus Signal to Noise (TN228).

•

If you already have coated beads for an affinity column then you can use them for your KinExA experiment. Refer to Solid Phase Selection
Guide (TN222) for bead requirements.

•

It is sometimes possible to reduce cost by reusing beads for subsequent experiments. For more information on reusing beads refer to
Reusing Beads (TN226).

Labeling the CBP
• If the CBP is an antibody, it can be indirectly labeled with a fluorescent anti-species secondary antibody.
•

If the CBP is not an antibody but contains a tag of some kind (e.g. biotin or HIS), then labeling can be directed at the tag.

•

If the CBP is not an antibody and lacks a tag, a complimentary antibody that is directly or indirectly labeled can be used.

For more information on labeling see Labeling Strategies (TN223).

Immobilizing the Titrant
The purpose of the solid phase is to act as a probe to measure the free CBP in solution. From the captured CBP, the Kd between the CBP and Titrant is
determined. It does not matter if the Kd or kon of the CBP to the solid phase is different than to the solution Titrant.
The same Titrant that is used in the samples is commonly used to coat the solid phase because it will compete for the binding site of interest. An
analogue (e.g. a cross reacting target or an anti-idiotype antibody) can be used in place of the Titrant, as long as it is competitive for the same
binding site on the CBP.
Immobilization of the Titrant can be achieved through adsorption or covalent coupling. There are a variety of solid phases available that can be used
for KinExA measurements. The characteristics of the Titrant will determine if it can be successfully immobilized.
For more information on choosing a solid phase based on the characteristics of the coating material see Solid Phase Selection Guide (TN222).
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Equilibrium Timing Setup
The easiest way to start a new experiment is from a template
(File→New→New from Template, Figure 3A-3B) which can then be
customized as needed. The timing setup tab allows the user to adjust
experimental parameters. Use the figures and explanations below to help
understand the different aspects of the equilibrium timing setup.

Figure 3A. Opening a new template.

Constant Binding Partner (CBP) and Buffer/Label (Figure 4)

Figure 3B. Experiment Templates.

The first section of the timing setup allows the user to input the concentration of the Constant Binding Partner (CBP). The Molecular Concentration
does not include the valency of the binding partner. The Binding Site Concentration is automatically calculated when the Molecular Concentration and
Valency values are specified. If no unit is applied to the concentration, the value will default to nM. This information is only used when calculating
the Active CBP or Active Titrant during analysis. The value can be adjusted after the experiment is complete, if needed.

Figure 4. CBP and Buffer/Label identifiers.

The Buffer/Label section allows the user to input information about the buffer or label used. The information does not affect the measured samples
or analysis. Under Label Concentration if no unit is specified, the default is in μg/mL.

Rack Setup & Excitation Level: Autosampler & 4000 Only (Figure 5)
When using an Autosampler or 4000, install the sample racks that will be most relevant to you. An example of the Rack Setup is shown in Figure 5.
Note: Rack 1 is situated next to the standards rack. See Appendix for sample rack numbering.
The 4000 has the capability of changing the Excitation Level, which defaults to High. Although the High setting is recommended, there may be cases
when you would like to see less fluorescent emission. If that is the case, you can change the setting by using the drop down menu and selecting
either Low or Medium.

Figure 5. Location of Rack Setup and Excitation Level.
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Bead Handling (Figure 6)
The Bead Handling always defaults to Soft Beads. If Hard Beads will be used, select the bead handling icon from the tool bar (
) or change the
type under the Edit menu (Edit→Bead Handling→Hard Bead Handling). The pre-set bead handling parameters have been determined through
experimental testing. They can be changed to fit specific needs, but in most cases the Particle Reservoir line (highlighted in blue in the KinExA Pro
Software) will be the only parameter changed along with which Particle Reservoir is used.
The Particle Reservoir volume controls the bead pack height (seen through the Flow Cell Camera). The volume may be adjusted by changing either the
volume or the time. Make changes as necessary so the bead pack height seen on the camera is at or near the Set line. Changes to the default
parameters will not be saved until the Tab key is pressed.
Note: If changing the flow rate for the Particle Reservoir or any parameter after the Particle Reservoir, make sure not to go over 1
mL/min for soft beads or 3 mL/min for hard beads.
If using the Bead Retriever (available for the Autosampler and 4000), select the Use Bead Retriever Box and designate the position in the Standards
Rack with the drop down menu.

Figure 6. Bead Handling.

Sample Timing (Figures 7 and 8)
The number of samples within a Sample Set can be adjusted as needed. The concentration associated with each sample refers to the Titrant and is
used when analyzing inhibition curves. For more information on adjusting sample sets or designating concentration see KinExA Pro Software
Shortcuts (TN209).
Note: Whenever the flow rate is adjusted for a Sample Set, the following Buffer step should be changed to match the sample flow
rate. This ensures the entire sample passes over the bead column at the same rate. When using the Autosampler or 4000, increase
this Buffer step volume to 750 µL when using faster flow rates.

Figure 7. Sample Timing for Autosampler and 4000.

Copyright© 2019 Sapidyne Instruments Inc.

Page 8

UM200R1

Figure 8. Sample Timing for 3X00 models.

In an equilibrium experiment, the sample after the first Buffer wash is often used for the Label. In Figure 7, the location of the Label is in the
Standards Rack, Tube 1. In Figure 8, the Label location is the Inject. As with the Sample Set, the following Buffer step should match the Label flow rate.
Whatever volume is specified for the Sample Set or Label line is what will be drawn for the experiment. Ensure enough sample volume is prepared to
satisfy this parameter. The final buffer wash has an increased flow rate to wash away any unbound label in the flow cell.
When preparing samples there should be an additional “dead” volume included, 100 µL extra is typically needed however as little as 10 µL can be
used in conjunction with the Autosampler or 4000. For more information on reducing sample volumes refer to Minimum Sample Volume (TN206).
When using 3X00 models, an additional charge volume of 400 µL is needed for both the samples and the label. Prior to starting the experiment, each
sample line needs to be filled with the sample to ensure the appropriate volume flows over the bead pack.
For more information on how the timing file relates to the pressure data, see Pressure Data (TN214).
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Preliminary Tests
CBP Concentration: Signal Test
Purpose
A Signal Test is an experiment used to determine the following:
1. Appropriate Constant Binding Partner (CBP) concentration for subsequent equilibrium experiments.
2. Type of solid phase and appropriate coupling material to capture free CBP. For more information on solid phase selection see Solid Phase
Selection Guide (TN222).
3. Type of label to detect captured free CBP. For more information on labeling see Labeling Strategies (TN223).
A Net Signal is calculated by subtracting a Non Specific Binding (NSB) signal from a measured signal. A Signal 100% (Sig100) represents the voltage
when there is only CBP in a sample. When performing a Signal Test, NSB is approximated as the instruments response with no CBP.
Total Net Signal equation:

A net signal less than 2.0 V typically provides linear data when using the standard red filter set. If the net signal is below 0.5 V, noise may interfere
with the data. If the net signal is above 2.0 V, saturation of the solid phase can affect the linearity of the signal. For more information on linearity
refer to Linear Range (TN224).

Procedure
When preparing samples, it is important to note that the molecular concentration of the CBP does not include valency. For example, a 50 pM
(molecular) solution of IgG, which has a valency of two, would have a CBP value of 100 pM (binding site concentration).
Note: For this manual, unless specifically stated, concentrations refer to the binding site concentration because a 1:1 binding
model is used in analysis.
1. Determine the starting concentration of the CBP. A typical starting concentration is 1 nM with a 10 fold dilution. An NSB point should also
be included to gather information on the background binding of the label which is made from sample buffer only.
2. Samples and label should be prepared in sample buffer. The standard KinExA sample buffer is 1x PBS, 0.02% Sodium Azide, 1 mg/mL BSA,
pH 7.4. A typical starting volume is 500 μL per sample run.
Note: BSA is used to help reduce NSB as well as to prevent material from sticking to the walls of the container.
3. Prepare enough sample to run duplicate measurements and to account for dead volume, see Sample Preparation for an Equilibrium
Experiment (HG232) for additional information. If several bead types are to be tested make enough sample to run additional cycles.
4. Prepare enough label for the full experiment. For most labels (e.g. Dylight 650, Alexa 647, etc.) the standard concentration is 0.5 μg/mL.

5. For additional information on setting up the timing file see Understanding the Equilibrium Timing Setup section.
Results
1. Determine the average signal for each sample by averaging the duplicate runs.
2. Find the net signal by subtracting the NSB from the averaged signal for each sample. A reasonable goal is to obtain a net signal between
0.5 V and 2.0 V.

Using Signal Test Results
It may be necessary to alter the experiment parameters to optimize the Sig100, for more information refer to Increasing the Signal (TN225).
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Titrant Concentration: Range Find
Purpose
A Range Find is an experiment used to determine the range of Titrant concentrations necessary to obtain a complete experimental curve. Preferably,
both ends of the experimental curve should be defined to make accurate Kd, CBP, and Titrant concentration measurements. The range of Titrant
concentrations ideally:
a) bind a very small amount of active binding sites, leaving nearly 100% of active binding sites free in solution.
b) bind a significant amount of active binding sites, leaving nearly 0% of active binding sites free in solution.
c) bind between 0% and 100% of active binding sites, resulting in a complete experimental curve.
This preliminary experiment helps determine the fraction of active binding sites that are left free in solution at specific Titrant concentrations.

Procedure
1. Use the CBP concentration and sample volume that generated good signal in your signal test.
2. Choose three or more Titrant concentrations. At a minimum, use Titrant concentrations one order of magnitude higher, one order lower,
and one equal to the CBP concentration. For example, if the CBP is 100 pM use at least Titrant concentrations of 1 nM, 100 pM, and 10 pM.
3. Samples and label should be prepared in sample buffer. The standard KinExA sample buffer is 1X PBS, 0.02% Sodium Azide, 1 mg/mL BSA,
pH 7.4. Prepare enough for:
a) Each titrated sample
b) CBP only (Signal 100%)
c) Sample Buffer only (NSB)
d) Label
4. Prepare enough sample and label volume to run duplicate measurements (2 cycles). Refer to Sample Preparation for an Equilibrium
Experiment (HG232) for additional information.
5. Prepare the instrument for a Range Find using the Equilibrium→Range Find template. Select the appropriate number of lines in the
sample set or specify the location of the samples. Allow the samples to equilibrate for 30 minutes to one hour. It is not critical for all the
samples to be at equilibrium for this test. The purpose is to see where saturation of the CBP occurs and where there is 100% free.

Results
1. The Instrument tab will have the data traces graphed per sample. Select the Binding Signals page. Look for any unusual traces or data
points.
2. Select the Binding Curve tab and click the Analyze experiment icon (
) in the software. Four or more data points (not designated as
the Sig100% or 0) is enough data to analyze the experiment; however, the results are preliminary and may not be reliable.
3. Use the analyzed data to choose a range of Titrant concentrations for a standard Kd measurement.
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Equilibrium Experiment
Purpose
The goal of an equilibrium experiment is to determine the equilibrium dissociation constant (Kd) for a particular system. A successful measurement
requires that the constant binding partner (CBP) concentration not be too far above the Kd (See Theory Curve, A Guided Tour Part 1 (TN220)). There
may be an approximate Kd value known in which case the CBP should be set around 5 or 10 times above the expected K d. If the Kd is completely
unknown it’s reasonable to use the concentration of CBP that gave a good net signal, using standard volumes and flow rates, in the Signal Test and
Range Find.

Procedure
1. Use the information from the signal test and range find to determine the following:
a)
b)
c)
d)

the CBP concentration needed to obtain a good signal
the volumes necessary to perform the assay
the starting concentration of the Titrant
the serial dilution factor, a typical dilution factor is 2 fold
Note: For more information about serial dilutions see Determining Dilution Series (TN203) or Large Volume Serial
Dilutions (HG231).
e) an estimate of the time necessary to reach equilibrium.
Note: For more information on estimating time to reach equilibrium see Theory Curve, A Guided Tour Part 3
(TN220).
2. Prepare the samples. For more information see Preparation of an Equilibrium Experiment (HG232).
3. Prepare the instrument and use the Equilibrium Experiment template (New from Template→Equilibrium).
4. Allow enough time for samples to reach equilibrium prior to starting the experiment. If kon is unknown, it is reasonable to allow samples
to come to equilibrium overnight.

Results
When the experiment is complete, the Instrument tab displays the data traces along with each sample's signal. To analyze the experiment navigate
to the Binding Curve tab and confirm that the correct concentration reference, Titrant or CBP, is selected (see Concentration Reference below).
Analysis is performed with a single click of the Analyze button (
) in the tool bar.
The error curves and 95% confidence intervals for the analyzed data are under the Error Curves tab and an easy-to-print summary of the
experimental parameters with data analysis is available on the Summary page.
Concentration Reference:
1. On the Binding Curve page, select the appropriate analysis concentration reference:
a) If the Titrant Partner analysis is used (Calculate CBP Activity), the user specified Titrant concentrations are assumed to be
correct. The software computes the Kd and active CBP concentration based on the given Titrant concentrations. The calculated
answers are directly related to the accuracy of the Titrant concentrations (e.g. if the Titrant concentrations are off by 20%, then
the calculated Kd and active CBP concentrations will also be off by 20%).
b) In cases where there is more confidence in the concentration of the CBP rather than the Titrant, then the Constant Partner
analysis should be used (Calculate Titrant Activity). This analysis ties the results back to the CBP concentration and reports the
Kd and Titrant activity. Similar to the Titrant Partner analysis, the calculated results are directly related to the accuracy of the
given CBP concentration.
c) If you are unsure as to which analysis to use, refer to KinExA Analysis (TN229) for additional guidance.
Copyright© 2019 Sapidyne Instruments Inc.
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2. If the results obtained did not give satisfactory error curves or further verification is needed, then additional curves should be measured.
These curves can be analyzed together in the n-curve analysis software.
a) To improve the bounds for the CBP activity, use a higher CBP concentration.
b) To improve the bounds for the Kd value when using the Titrant Partner analysis, use a lower concentration of the CBP. If signal is
a problem, refer to Increasing the Signal (TN225).
c) To improve the bounds for the Kd value when using the Constant Partner analysis, you may need either a higher or lower
concentration of CBP. To help in understanding why this is, and to determine which direction, see KinExA Analysis (TN229).
Note: For more information on error curves and 95% confidence intervals, see KinExA Error Curves and the 95% Confidence Interval
(TN207).

Whole Cell Equilibrium Experiment
The KinExA instrument can be used to measure binding affinity of a soluble molecule to surface receptors of intact cells. For information on cell
based measurements and guidance for interpreting the results see Whole Cell Assay (TN211). Refer to Whole Cell Equilibrium Experiment (HG261) for
more information on our recommended procedure for setting up whole cell equilibrium experiments.
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Analysis: n-Curve
Purpose
The n-Curve analysis gives users the ability to analyze multiple curves simultaneously. This is advantageous when analyzing equilibrium and kinetic
experiments or combining data.

Analyzing Equilibrium Experiments with the n-Curve Analysis
The n-Curve analysis locks the concentration difference between the stated CBP values of the curves included in the analysis. Locking the CBP
difference in this way provides an additional parameter on the curve fitting that usually results in more narrow confidence intervals for both the K d
and activity. In addition, an n-Curve analysis can reveal deviations from 1:1 binding (e.g. Cooperativity) and calculation or pipetting errors in the
experimental setup.
While it is sometimes informative to analyze two curves with the same CBP concentration, a concentration difference resulting in a 10 fold or greater
spacing between the curves is recommended for good information about the Kd and CBP Activity.

Procedure

1. Open the KinExA Pro software. Under Tools, select n-Curve Analysis (
2. Once the program opens, select Add Experiment (

).

) from the tool bar.

3. Browse folders for the experiments that are to be analyzed on the same axis. Up to 20 experiments may be added.
4. To remove an experiment, select the experiment title and click on Remove Experiment (

).

5. Choose the appropriate analysis method.
Note: The chosen analysis method overrides individual experiment selections.
6. Select Analyze Experiment (
)

Results
To view the analyzed n-Curve data, select the n-curve analysis header and then select the Binding Curve tab for the curves or the Error Curve(s) tab for
the associated error graphs. A summary of the entire n-curve analysis is available on the Summary tab.
Note: Individual curves can be selected to view isolated analysis information by clicking the experiment title.
1. Under the Binding Curve page, the theoretical curves (solid line) should fit each data set with minimal error. If there is a discrepancy in the
fit, then the data should be looked at critically in order to identify the reason.
a) The spacing between curves is strongly affected by the factor of difference in the CBP concentrations. If one of the CBP
concentrations is not correct, that can contribute to a poor fit.
b) Complicated binding, such as cooperativity, can contribute to a poor fit with the standard model. For more information on
cooperativitiy, refer to Cooperativity (TN213).
c) For more resources to help look at data critically, refer to the following technical notes.
• Drift Correction (TN205)
• KinExA Error Curves and the 95% Confidence Intervals (TN207)
• Titrant Related NSB (TN210)
• KinExA Analysis (TN229)
Note: If you have questions, please contact a Sapidyne representative for clarification.
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Combining Data
There may be a situation where an experiment was running but did not complete. If there is still sample left to run, a new experiment file needs to
be created to run the remaining samples. Once the experiment is complete, both sets of data can be combined and analyzed as one experimental
curve. To do this, refer to Combining Data (HG247). Combining data is also commonly used to analyze kinetic experiments. When using the
Autosampler or 4000, manual kinetic points can be combined with other time points to better define the association rate constant. For more
information refer to Manual Kinetics Direct (HG244).
Note: Combining data can only be accomplished in the n-Curve software.
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Kinetic Measurements
Kinetics refers to the speed of a reaction when two reagents associate and dissociate. The rate at which the two reagents associate is proportional to
the Association Rate Constant, “kon”. The rate at which the complex dissociates is proportional to the Dissociation Rate Constant, “koff”. The length of
time it takes for a sample to come to equilibrium is determined by not only the kinetic rate constants, but also by the Kd and the concentrations used
in the samples.
The Kinetics Direct method measures the free active binding sites of the CBP over time as the reaction proceeds towards equilibrium. If the reaction
happens too quickly to be measured by the Direct method, the Manual Kinetics Direct can be used on the Autosampler or 4000. For more
information, refer to Manual Kinetics Direct (HG244).
KinExA 3X00 models also have the capability to perform Kinetics Injection experiments. In this experiment, the free active binding sites of the CBP
are measured pre-equilibrium at varying Titrant concentrations and a fixed reaction time. This type of experiment is typically used when Manual
Kinetics direct cannot be used.
For accurate kinetic measurements, it's important that data points be obtained through enough of the curve to determine a proper fit. It is also
important that the active concentration of the binding partners are entered in the Timing Setup page. Typically, this information is provided from the
results of an equilibrium experiment (Equilibrium Experiment section). The active concentration will not only help in setting up the kinetics
experiment using the theory curve, but will also influence the analyzed kon and koff. If the active concentrations are not known at the time of the
kinetics experiment they can be corrected afterwards.

Kinetics Direct
In this method the CBP and Titrant are mixed into one sample and the concentration of free CBP is measured over time. As the reaction progresses,
the number of free active binding sites will decrease until equilibrium is reached. The signals from each measured time point are analyzed using the
Kinetics Direct analysis.
This method will be successful when the time to reach equilibrium is long enough to allow for several measured points to be obtained prior to the
mixture reaching equilibrium as seen in Figure 9. If the time to reach equilibrium is too fast using the Kinetics Direct, it is possible to run faster data
points using the Manual Kinetics Direct for 4000 or Autosampler models, or it might be more appropriate to run Kinetics Injection experiments for
3X00 models. If you are unsure how quickly the reaction will happen, it is best to start with the Manual Kinetics Direct if a 4000 or Autosampler is
available. For more information refer to Manual Kinetics Direct (HG244).

Figure 9. Using a Titrant concentration producing 80% inhibition.
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Choosing Concentrations
The Kinetics Time Course Curve on the Theory Curve can be used to determine optimal concentrations of the active CBP and Titrant for the Kinetics
Direct experiment. See Theory Curve (TN220) for more information.
In most cases when running Kinetics Direct experiments, you will want to make the reaction go as slow as possible. If you want to speed up the
reaction, the Titrant concentration can be increased.
As a general rule, a Titrant concentration
that will produce 80% inhibition of the
antibody at equilibrium (20% free binding
sites) provides the best compromise
between slowing the reaction and giving a
good measurable range. The 80% inhibition
concentration is determined using the Kd
value from a previously run equilibrium
experiment.
When the 80% inhibition point is used the
experiment will progress from 100% free at
the start of the experiment to 20% free at
equilibrium (Figure 9). The straight dotted
line shown in Figures 9-11 represents the
point at which the experiment comes to
equilibrium. If a lower Titrant concentration
is used, the equilibrium line moves closer to
100% and the measurable range decreases
(Figure 10).

Figure 10. Using a Titrant concentration producing 40% inhibition

Figure 11. Using a Titrant concentration producing 94% inhibition

If a higher concentration of Titrant is used the reaction occurs more quickly with only a minor change to the measurable range. This may result in
fewer measured data points before reaching equilibrium (Figure 11). Obtaining more points prior to the equilibrium increases confidence in the
result.

Procedure (Autosampler and 4000)
Use the information from the previous equilibrium experiments and the theory curve to prepare the following:
1. The concentration of CBP and volume necessary to obtain a good signal.
a) Each binding partner must be prepared at twice the final concentration in half the final volume to achieve the correct final volume
and concentrations after mixing. This is because the CBP and Titrant samples are prepared separately in sample buffer, then mixed
together immediately before the assay is run.
b) Use the equation below to help determine the final volume of sample needed.
Total Sample Volume = (Sample volume)(cycle#) + (dead volume)
2. Prepare enough Label for all of the cycles in sample buffer.
a) Use the equation below to help determine the total label volume needed.
Total Label Volume = (Label volume)(cycle#) + (dead volume)
Copyright© 2019 Sapidyne Instruments Inc.
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3. Prepare additional tubes for each sample run that contain only buffer.
4. Prepare the instrument for the experiment using the Kinetics Direct template.
a) Place the additional buffer tubes in the locations designated in the sample set (Figure 12B).
b) Place the Label in the location designated after the sample set (Figure 12C).
5. When you are ready:
a) Select the Clock (
) button on the Instrument tab. This will initiate a 5 second countdown.
b) At the end of the countdown, the prompt “Mix” will appear. Combine the samples and mix well by pouring samples back and forth
between the two tubes 3-4 times. A pipette may be necessary to transfer all the sample from one tube to the other. If there is plenty
of sample, leaving a little residual sample behind is okay if mixed properly.
c) Immediately place the sample into the designated rack position (Figure 12A) and select Start. “Complete” will appear in the lower
left-hand corner of the Instrument page when the experiment is completed.

Figure 12. Timing file for Kinetics Direct. (A) Sample Location, (B) Buffer tube locations,
and (C) Label location.

If using Low Dead Volume Tubes, the dead volume can be reduced to as little as 10 μL. For more information refer to Minimum Sample Volume
(TN206).

Procedure (3X00 Models)
Use the information from the previous equilibrium experiments and the theory curve to prepare the following:
1. The concentration of CBP and volume necessary to obtain a good signal.
a) Each binding partner must be prepared at twice the final concentration in half the final volume to achieve the correct final volume
and concentrations after mixing. This is because the CBP and Titrant samples are prepared separately in sample buffer, then mixed
together immediately before the assay is run.
b) Use the equation below to help determine the final volume of sample needed. Standard charge volume is 400 µL.
Total Sample Volume = (Sample volume)(cycle#) + (dead volume) + (charge volume)
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2. Prepare enough Label for all of the cycles in sample buffer.
a) Use the equation below to help determine the total label volume needed.
Total Label Volume = (Label volume)(cycle#) + (dead volume) + (charge volume)
3. Prepare the instrument for the experiment using the Kinetics Direct template.
a) Charge the Label and Beads. This helps reduce the time it takes to obtain the first time point.
4. When you are ready:
a) Select Charge Lines from the Instrument tab. Be sure the boxes next to Line 1 and Buffer have a red check mark. The Particle
Reservoir and Label can be deselected.
b) Select the Clock (
c)

) button on the Instrument tab. This will initiate a 5 second countdown.

At the end of the countdown, the prompt “Mix” will appear. Combine the samples and mix well by pouring samples back and forth
between the two tubes 3-4 times. A pipette may be necessary to transfer all the sample from one tube to the other. If there is plenty
of sample, leaving a little residual sample behind is okay if mixed properly.

d) Immediately place the sample on Line 1 and select Charge/Start. “Complete” will appear in the lower left-hand corner of the
Instrument tab when the experiment is completed.

Results
1. The Instrument tab will have the data traces graphed with binding signal versus time. Select Analyze Experiment (
will be analyzed.

) and the data

2. The Binding Curve tab contains the binding curve fit to the experimental data. It includes the fitted kon and the calculated koff.
3. The Summary tab includes signals, error curves, data traces, and the determined kon and calculated koff values.

Whole Cell Kinetics Direct
The KinExA instrument can be used to measure the kon of a molecule to a cell surface receptor. For this experiment, a fixed number of cells are
incubated with a fixed Constant Binding Partner (CBP) and samples are measured at varying time points pre-equilibrium. Prior to running each
sample, however, all cells must be removed from solution (if left in samples they can clog the flow cell screen). The incubation time of the cells and
CBP for each sample must be recorded for accurate data analysis.
For more information about setting up and running a whole cell kinetics experiment, see Whole Cell Kinetics (HG249).
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Kinetics Injection (3X00 Models)
In the Kinetics Injection method the concentration of one binding partner is held constant (CBP), and the other partner is titrated in a background of
sample buffer (Titrant). This experiment measures the amount of active CBP that is free in solution at a specified incubation time for each Titrant
concentration. The incubation time is held constant and can be adjusted by changing the flow rate using the timing setup parameters. The contact
time between the molecules can be reduced to ~3 seconds to measure very fast on rates. This makes the Kinetics Injection method more aptly suited
for systems that reach equilibrium rapidly.
Data is collected for each Titrant concentration and these signals are analyzed to get a kon. For an accurate kon determination, it is important that data
points throughout the entire curve are obtained. In other words, a range of Titrant concentrations should be used that:
a)

Bind a minute amount of active CBP sites, leaving nearly 100% of these sites free in solution.

b)

Bind a significant amount of active CBP sites, leaving nearly 0% of these sites free in solution.

c)

Bind between 100% and 0% of active CBP sites (Figure 13).

Procedure
Equilibrium Line

Step 1: Understanding the Kinetics Injection Timing File
The sample timing for the Kinetics Inject templates are different than
what you've seen in the affinity templates. Refer to Sample
Preparation for Kinetics Injection Experiments (HG233) for more
information on setting up a Kinetics Injection experiment.
Step 2: Optimize Injection Experiment Parameters

Figure 13. Range of titrant concentrations that encompass the entire curve at a
contact time of 9.67 sec.

The procedures below can be performed prior to running the full
experiment. These steps can be skipped if you have sufficient signals
and have an idea from the theory curve on what concentration of Titrant to use.

•

Choose the number of samples for your experiment and a starting concentration for the first CBP sample (Signal 100%). A good starting
concentration is the same one used for the equilibrium experiment.

•

Determine the dilution factor you want to use. See Determining the Dilution Series (TN203) for help.

1)

Signal Test
a) When mixing occurs on the instrument, the flow rate and volume increase causing a slight decrease in signal. Remember, this is not
an experiment to determine the Kd so the CBP concentration that is chosen can be above the Kd of the system making it easier to
produce robust signals.
b) Prepare the samples. The concentration of the CBP should be doubled since it will be injected into an equal volume of sample buffer.
c)

2)

Prepare the instrument for the experiment by using the Kinetics Injection Signal Test template.

Range Find
a) The range find experiment determines the range of Titrant needed for the full Kinetics Injection experiment.
b) Use the Theory Curve to determine the appropriate Titrant concentrations to test. See Theory Curve (TN220) for more information.
c)

Prepare the instrument for the experiment by using the Kinetics Injection Range Find template.
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Step 3: Kinetics Injection Experiment
Refer to Sample Preparation for Kinetics Injection Experiments (HG233) for more information on preparing a the samples and understanding the
timing file.
Results
1. The Instrument page will have the data traces graphed with sample signal versus time. Select Analyze to analyze data.
2. The Binding Curve page contains the theoretical binding curve fit to the experimental data. It includes the measured kon and calculated koff.
The experimental data should not be directly on top of the green dotted line as this would indicate the experiment reached equilibrium
within the allowed mix time.
Note: If it's difficult to see the experimental data on the theory line, select the Logarithmic X-Axis option on the left hand
side of the Binding Curve page. This changes the scale from a linear axis to a logarithmic axis for better resolution. For
older software versions, right click on the graph and select Axes from the available tabs. Designate a check mark in the
IsLogarithmic option.
3. The Summary page includes signals, error curves, data traces, the determined kon and calculated koff values.
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Concentration Measurements
The KinExA instruments can be used to determine unknown sample concentrations with a high level of sensitivity and accuracy. Both sandwich and
inhibition assay formats are supported.
Use the flow chart below when setting up your Concentration Immunoassay Measurements.

Concentration Immunoassay Flow Chart
Determine the Type of Immunoassay to Setup
Concentration Immunoassay (TN218)

Inhibition Immunoassay

Sandwich Immunoassay

Determine the Appropriate Solid Phase
Solid Phase Selection Guide (TN222)

Determine the Appropriate Label
Labeling Strategies (TN223)
Analysis

Sandwich Assay
Molecules that can be captured on the solid phase and subsequently labeled with a complimentary molecule can be measured using the Sandwich
Assay. Signals generated from the standard curve of known concentrations are used to calculate the unknown concentration of specified samples.

Inhibition Assay
In cases where a sandwich assay is not feasible, such as measuring small molecules, an inhibition assay can be performed. For the inhibition assay an
exact solution of the bimolecular binding equation is fit to the standard curve and used to interpolate the unknowns.
For more information about setting up and running an immunoassay using the KinExA Instruments, see Concentration Immunoassays (TN218).
Copyright© 2019 Sapidyne Instruments Inc.
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Instrument Overview: KinExA 4000
Use the illustrations in Figures 14-16 along with the lettered descriptions to identify KinExA 4000 parts.

K

L

A

J

F
E
D

G

B C

H
I

Figure 14. Front view of the Instrument

A) Optics Cover: Shields the flow cell from light.
B) EverExcite Panel: Displays the LED power level.
C) Instrument Status Panel: The blue light indicates power to the instrument. The green light indicates the instrument is ready. The yellow
light indicates the instrument is busy and the red light indicates an error.
D) Wash Station: Location of the buffer and waste which the Sipper Tube accesses during the backflush and sample handling.
E) Standards Rack: 50 mL tube holder. Commonly used for a label position or wash solutions in experiment templates.
F) Autosampler Arm: Moves to designated positions and draws or expels samples.
G) Sampling Area: Location for sample racks. Sample racks can be interchanged as needed.
H) Particle Reservoir: Coated particles in a vial can be placed in any of the [4] positions available, and the mechanical stirrer lifts them into
suspension before they are drawn into the flow cell.
I)

Internal Light Switch: Turns on the interior light for a better view of the sampling area.

J)

Door: Covers the sampling area and Autosampler arm.

K) Door Anchor: Location to hang the door when not in use.
L) Plumbing Access Panel (not seen from this angle): Door covering the Plumbing Panel.
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Behind the Plumbing Access Panel

H

S

T

Figure 15. Plumbing Panel.

M) Aspiration Pump: This syringe pump pulls buffer and sample through the flow cell.
N) Pressure Transducer: Monitors the pressure while the instrument is running.
O) Degasser: This is a gas permeable Teflon membrane used to remove dissolved gas from the buffer before it passes through the flow cell.
P) Backflush Isolation Valve: Closed except during operation of the Backflush Pump.
Q) Backflush Filter: Filters small particles to prevent clogging subsequent valves.
R) Buffer Filter: Filters small particles to prevent clogging subsequent valves.
S) Backflush Pump: A peristaltic pump that provides a reverse flow to lift used particles off the screen and flush them out to waste.
T) Buffer Pump: A peristaltic pump that provides buffer to the Wash Station.
U) Level Sensor Connection: Electrical connection for the Level Sensors.
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Behind the Optics Cover

Y

x
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W

Figure 16. Behind the Optics Cover.

V) Camera: Provides live video feed of the flow cell. Saves pictures of the bead pack before and after each sample run.
W) Reflector Arm: Reflects both excitation and emission light back into the flow cell.
X) Flow Cell Retention Clip: Holds the flow cell against the lens. Slide this clip to the right to allow removal of the flow cell from the lens.
Y) Detent Pin: Holds the Reflector Arm closed.
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Instrument Overview: KinExA 3X00
Use the illustrations in Figures 17-19 along with the lettered descriptions to identify parts of the KinExA 3X00 instrument.

Figure 17. Illustration of the front panel.

A) Particle Reservoir: Coated particles are placed in this vial, and the mechanical stirrer lifts them into suspension before they are drawn
into the flow cell.
B) Particle Pinch Valve: Controls the flow of particles from the Particle Reservoir to the flow cell.
C) Waste Pinch Valve: Opens during Backflush mode to allow the used particles to be flushed to the waste container.
D) Backflush Pump: A peristaltic pump that provides a reverse flow to lift used particles off the flow cell screen and flush them out to waste.
E) Sample Isolation Valve: Controls the flow of samples between the Sample Selection Valve and the flow cell. Normally open, but closes
when either the Particle Pinch Valve or the Waste Pinch Valve is open.
F) Sample Selection Valve: Also known as the 14-Port. Used to switch between the various samples. Port 1 is permanently connected to
buffer.
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G) Optics Cover: Shields the flow cell from light.
H) Backflush Isolation Valve: Closed except during operation of the Backflush Pump.
I)

Four Way Connector: A passive fitting that serves as a junction connecting flow paths from the Particle Pinch, Sample Selection, and
Waste Pinch Valves to the flow cell.

J)

Injection Pump: This syringe pump is used to inject a reagent into a stream of sample from the Sample Selection Valve before it reaches
the flow cell.

K) Aspiration Pump: This syringe pump serves to pull buffer and sample from the flow cell or backflush lines.
L) Degasser: This is a gas permeable Teflon membrane used to remove dissolved gas from the buffer before it passes through the flow cell.
M) Lamp Access Door: Allows access to the lamp for lamp replacement.
N) Lamp Switch: Turns lamp on and off.
O) Pressure Transducer: Located behind the Degasser. Monitors the pressure while the instrument is running (3100 and 3200 models).
P) Indicator Panel: Green lights indicate power to the instrument and lamp. For the 3200, the yellow light indicates the instrument is busy
and the red light indicates an error.
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Behind the Optics Cover

Figure 18. Illustration of the components behind the optics cover.

Q)

Reflector Arm: Reflects both excitation and emission light back into the flow cell (also seen in Figure 19).

R) Optics Slide: Contains both the Dichroic Mirror and the Emission Filter.
S) Detent Pin: Holds the Reflector Arm closed.
T) Lamp Alignment Window: Window used to manually align the lamp if not using the EZ Align tool (P/N 800510). Passage of the
excitation light through the pinhole is visible through this window when the instrument and the lamp are on.
U) Excitation Filter: Allows passage of only the optimum wavelengths for exciting the fluorescent molecule of interest. The standard filter
set is red.
V) Camera: Provides live video feed of the flow cell. Saves pictures of the bead pack before and after each sample run (3200 model).
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Optics Slide

Figure 19. Illustration of the optics slide.

W) Dichroic Mirror: Reflects the excitation light and allows passage of the fluorescent emission.
X) Emission Filter: Blocks reflected excitation light and allows passage of the fluorescent emission to the photo detector.
Y) Flow Cell Retention Clip: Holds the flow cell against the lens. Slide this clip back to allow removal of the flow cell from the lens.
Z) Reflector Arm: Reflects both excitation and emission light back into the flow cell (also seen in Figure 18).
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Instrument Specifications
KinExA 4000

KinExA 3200

KinExA 3000/3100

Autosampler

Size
(H x W x D cm)

54 x 83 x 38

42 x 44 x 47

42 x 44 x 47

52.2 x 28.1 x 56.5

Weight

37 kg (82 lbs)

26 kg (57 lbs)

25 kg (55 lbs)

21 kg (46 lbs)

Power

120-265 V
50-60 Hz
0.8 A (max)
90 W (max)

85-265 V
50-60 Hz
1.8 A (max)
65 W (avg)

85-265 V
50-60 Hz
1.8 A (max)
65 W (avg)

100-240 V
50-60 Hz
1.8 A (max)
65 W (avg)

Power
Recommendations
Interface

Uninterruptible Power Supply (UPS)
Minimum Specifications: 750 Watt
Ethernet

Ethernet

Serial Cable

Serial Cable

Minimum Requirements
KinExA 4000

KinExA 3200

KinExA 3000/3100

Operating Ambient
Temperature

3°C - 40°C

Storage Temperature

3°C - 40°C

Environmental
Conditions

No direct sunlight

Operating System

Windows 7 or newer

Computer Hardware

512MB RAM, 32bit color display

Web Browser

Copyright© 2019 Sapidyne Instruments Inc.
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Chrome version 16+,
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Appendix
An Introduction to the KinExA Pro® Software
The KinExA Pro Software is a powerful tool for analyzing bimolecular interactions. Over the years, we have incorporated a variety of features and
general upgrades based on user feedback and experience. While software versions change over time, this introduction will give users an idea of what
to expect.
Note: The software is only intended for analysis of KinExA experiments. Using this software to analyze experiments performed on
different instrumentation is against our Terms of Service and will result in inaccurate data analysis.

Launching the KinExA Pro
When the software is first opened, the KinExA Pro – Welcome window will appear (Figure 1). From this window, the user can:

•

Create a new experiment using a template which has already been optimized depending on the experiment type (New from Template).

•

Create a new experiment using an existing file so that saved information and parameters from one file can be used to create another file
(New from Existing).

•

Create a new experiment that needs to be optimized by the user (New).

•

Open an existing file for viewing and analyzing (Open).

Figure 1. Welcome Screen.

This window will either need to be closed or an option will need to be selected to use other features within the software.
Once closed, the same options can be selected from [2] different locations in the software.
a)

Select File→New and then select the appropriate option or,

b) Select the drop down menu next to the blank page on the tool bar and select the appropriate option.
Once an experiment is run, another option from the drop down menu will be given, New from Current. New from Current allows the user to open a
new file based on the parameters of the file that is currently open. It will also close the file that was open in place of the new file, once selected.
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Categories & Templates
Depending on the software version, there can be up to [5] experiment categories. Within each category, there are templates that have been
optimized for your convenience. See Table 1 for a detailed description on the different categories and templates available.
Category

Template

Equilibrium

Signal Test

Template used as a preliminary step to determine the appropriate
concentration for the Constant Binding Partner (CBP), bead type, coating
material, and label type for subsequent experiments.

Range Find

Template used as a preliminary step to determine the appropriate starting
concentration for the Titrant.

Equilibrium Experiment

Template to run a full titration series for equilibrium affinity
characterization of soluble systems.

Whole Cell Experiment

Template to allow the incorporation of cells/mL for equilibrium affinity
characterization when binding to whole cells.

4000-Auto Kinetics Direct

Template optimized for the Autosampler or 4000 to determine kinetic
binding constants.

Kinetics Direct

Template optimized for the 3X00 series to determine kinetic binding
constants.

Kinetics Direct Whole Cell

Template which allows input of expression levels and cells/mL needed for
analysis of whole cell kinetic binding constants which can be used for all
instrument models.

Kinetics Injection Signal Test

Template for the 3X00 series to determine the appropriate CBP to use for
subsequent Injection experiments.

Kinetics Injection Range Find

Template for the 3X00 series to determine the appropriate starting
concentration for the Titrant.

Kinetics

Kinetics Injection
Concentration
Immunoassay

Description

Concentration Immunoassay
Autosampler Linear Response QA

QA

Cleaning

Injection-Aspiration QA

Template for the 3X00 series to determine kinetic rate constants that reach
equilibrium quicker than can be measured by the Kinetics Direct
experiment.
Template which incorporates analysis features to determine unknown
concentrations or test linear range of the CBP.
Quality assurance test to ensure the Autosampler and 4000 meet
operational qualifications.
Quality assurance test to ensure the 3X00 syringe valves meets operational
qualifications.

KinExA Linear Response QA

Quality assurance test to ensure the 3X00 instrument meets operational
qualifications.

Standard Wash

Wash template for the 4000 and Autosampler to rinse more thoroughly
between queued experiments.

Table 1. Descriptions of the different categories and templates available in the KinExA Pro Software.
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Useful Icons
Depending on the software version and template, some icons may not be available. Table 2 describes the different types of icons shown in the tool
bar.
Icon

Name
Bead Handling

Description
Adjust the Bead type from Soft to Hard. Whenever the type is changed, the timing will reset to default
parameters.

Insert Row

Add rows in the sample timing when optimizing sampling parameters.

Delete Row

Delete rows in the sample timing when optimizing sampling parameters.

Analyze
Flow Cell Camera
Initialize
Read Meter
Buffer Change
Backflush
Fill/Empty Inject
Rinse

During an experiment or when an experiment is finished, analyze generated data and generate 95%
confidence intervals.
View the live feed of the flow cell when adjusting beads or during an experiment.
Perform a diagnostic test to make sure the instrument is communicating appropriately.
Monitor the fluorescent output. Can be used to align lamps with the 3X00 Series or adjust excitation
levels in the 4000 series.
Change the buffer type with step by step instructions.
Perform a reverse flow to expel beads from the flow cell into waste.
Prime or clean the injection syringe barrel on 3X00 series.
Rinse various sample lines and particles reservoir lines on the 3X00 series.

Night Wash

Introduce a detergent to soak in the lines for 30 minutes prior to expelling to waste.

Fast Rinse

Rinse with a higher volume and flow rate.

Charge Beads

Set the bead pack height prior to experiments.

Charge Lines

Prime each sample line on the 3X00 series instrument.

Remove from Queue
Abort

Remove an experiment that is waiting to run without aborting the experiment that is currently running.
Stop instrument functions.

Table 2: Useful Icons in the KinExA Pro Software.
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Understanding an Experiment File
Experiment tabs are setup so that you work through them left to right in the order they will most likely be used. A description of each tab within an
experiment file and how to use each section is described below.
Experiment

•

Id: An identification number is associated with every experiment run on the instrument. The number is assigned when the experiment
starts. When experiments are backed up, you can find the associated file listed under the Id number.

•

Software Version: Not available in all versions of the software. This feature allows you to track which version was used to run experiments.

•

Experiment Name: The user can specify the name for each experiment. The experiment name is used as the file name.

•

Experiment Type: Records the type of experiment. If the Experiment Type is changed in this location, the Timing Setup will reflect the
original template designated.

•

Comments: Any notes about the experiment (e.g. Lot numbers or product numbers) can be written and saved. Once the experiment starts,
edits cannot be made to the Comments section. Below the Comments is another box to write notes, after the experiment has been started.

Timing Setup
Depending on the template, there will be different boxes that can be filled in to assist with analysis and record keeping as well as adjustable
parameters. Below is a brief description of the various boxes to fill in, parameters to adjust, and how they are used.

•

Constant Binding Partner (CBP): Enter the molecular concentration in the first box and then the valency in the 2nd box. The binding site
concentration will automatically be calculated. If no unit is entered, the default will be nM.

◦ If the Titrant Partner is used as the concentration reference, the activity of the antibody is calculated by dividing the measured
concentration by the binding site concentration.

◦ If the constant partner is used as the concentration reference, the binding site concentration is used to measure the Titrant
concentration.

◦ For kinetics experiments, enter the active concentration.
•

Buffer/Label: Enter in any details regarding the buffer and label. Label concentration defaults to µg/mL.

•

Titrant Concentration/Kd: In the kinetics experiment templates, enter the active Titrant concentration and measured Kd from subsequent
experiments.

•

Cells/mL & Expression Level: For cell kinetics experiments, enter the cells/mL and measured expression level (molecules/cell). The molar
equivalent will automatically be calculated.

•

Rack Setup: Make sure the racks used on the 4000 and Autosampler are correct. Refer to Figures 2 and 3 for the 4000 and Autosampler
respectively.

◦ The Z max can be adjusted in this location or in the default location (Options→Autosampler Configuration).
◦ If the Rack is changed here but different than default setting, you will be asked which setting to use.
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Figure 2. 4000 Position Chart.

Figure 3. Autosampler Position Chart.

•

Bead Handling: Soft beads are the default for any new template. This ensures they are not packed into the flow cell at a higher flow rate.

◦ To adjust the type of bead, use the bead handling icon (

) in the toolbar.

◦ Soft beads are run at 1.0 mL/min while hard beads are run at 1.5 mL/min.
Note: PMMA and Polystyrene beads are hard plastic, whereas Azlactone and Sepharose are soft.

◦ 3X00 Models: Adjust the bead pack height by adjusting the time or volume in the Particle Reservoir column. Press Tab after making
any changes.

◦ 4000/Autosampler Models: Select the appropriate Particle Reservoir and then adjust the bead pack height by adjusting the time or
volume. Press Tab after making any changes.

•

Sample Timing: Designates the location of samples.

◦ Volume and flow rate can be adjusted as necessary.
◦ To run a slow flow, select the drop down menu next to the flow rate, scroll to the bottom, and select slow flow. This allows for slow
rates as slow at 0.025 mL/min to be used. While fast flow can also be selected, that option is only used for diagnostic testing.

◦ A titration series can be entered in by typing in “Starting concentration of Titrant/dilution factor”. Additional concentrations can be
added by separating the values using a comma (no spaces).
Instrument

•

Options to Charge beads, Charge Lines (3X00 Models), Start, & Abort are accessible in this window.

•

If an experiment starts after one is already running, Remove from Queue will appear.

Copyright© 2019 Sapidyne Instruments Inc.

Page 35

UM200R1

•

Number of Cycles: This is the number of times that a sample set will be measured.

◦ For an equilibrium experiment [2] is common for duplicate points.
◦ For a kinetics experiment [10] is common for multiple time points.
•

Cycle Delay: Delays the time between cycles. Can be useful for kinetics experiments. Numbers entered should be whole integers.

•

Incubation Delay: Delays the start time of an experiment to allow equilibration to occur prior to starting. Numbers entered should be
whole integers

•

Units: Used for both the cycle and incubation delay. Can be set to minutes, hours, or days.

•

Clock Icon: For kinetics experiments, the clock is selected to initiate the mix time. A 5 second count down will appear. Once Mix appears,
the Mix Date and Time are recorded.

Binding Signals

•

The raw data is collected and recorded in this location.

•

Baseline/Endpoints: Time is averaged over the first 5 to 10 seconds at the beginning of the sample trace and for the last 10 to 5 seconds. If
these times are adjusted, the Compute Binding Signals button will need to be selected to adjust the binding signals appropriately.

•

Errors in the Titrant Concentration or Cells/mL can be adjusted if necessary for each sample.

•

Data points can be ignored due to bubbles or other anomalies and ignored in the analysis by selecting the box next to the desired biding
signal. A check mark will appear when selected.

Binding Curve
Once data is collected, a theory curve is fit to the experimental data once Analyze (

) is selected.

•

Select the appropriate concentration reference for equilibrium experiments. For more information refer to KinExA Analysis (TN229).

•

Incorporate Drift Correction (TN205) or Titrant Related NSB (TN210).

Error Curves
View resulting error curves for the Kd, Activity of CBP or Titrant, and/or Expression level. For more information on error curves refer to KinExA Error
Curves and the 95% Confidence Interval (TN207).
Summary
View and print a summary of all the data traces, parameters, and results. Sections can be removed by pressing X.
Additional Data

•

Charts: View signal traces in relation to the monitored pressure over time. Temperature is also recorded for 4000 models.

•

Camera: View saved camera images at the end of the bead handling and the end of the sample timing.

•

Signal Data/Pressure Data: Raw data collected during the course of the experiment.

Other Useful Software Features

•

Save Sanitized: Under File, the save sanitized option allows users to make a copy of the current experiment file that is devoid of
confidential comments or notes recorded in the file. This is useful for sending raw data to Sapidyne for data validation or questions.

•

Export: Under File, export the charts and analysis data as needed.

•

Resynchronize with Instrument: Under Instrument, If a computer is disconnected from a 3200 or 4000 model, it can be resynchronized
with the instrument for continued monitoring of data generation.
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•

N-Curve analysis: Under Tools, this option allows for multiple experiments to be analyzed on the same axis for a global fit.

•

Theoretical Binding Curve: Under Tools, this is a useful tool to aide in experiment setup and design, including information regarding
the time needed to reach equilibrium. Refer to Theory Curve (TN220) for more information on how to use the theory curve.

•

Instrument Designations: Select the appropriate instrument type under Tools→Options→Instrument Controller.

•

Calibrations: Under Tool→Options→Autosampler configuration. Adjust default setting for rack locations, z-max setting, and microtiter
plate calibrations for the 4000 and Autosampler.

•

Window: View and select different windows that are open in the KinExA Pro Software.

•

Help: View various manuals and access the KinExA Pro Software version. The version can be seen by selecting About KinExA Pro.
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KinExA Data Analysis
Standard equilibrium affinity analysis. Equilibrium affinities are calculated using the mathematical theory outlined in the following pages. Step
by step derivation of the equation used in the equilibrium binding curves is shown. Each assumption made is clearly described and the assumptions
are summarized at the end.
We begin with the definition of a reversible reaction at equilibrium:
Assumption 1: The binding in question follows the reversible binding equilibrium equation.

(1) kon · R · L = koff · RL
Where:
kon = forward rate constant
R = free receptor site concentration
L = free ligand site concentration
koff = reverse rate constant
RL = concentration of complex
Now, if we define K to be kon/koff (the affinity), we can rewrite equation (1) to be:
(2) RL = K · R · L

Where: K = kon/koff

Assumption 2: Receptor and ligand bind 1:1, such that total receptor equals receptor in complex plus free receptor. Then we can write two
equations relating total material to equilibrium distributions:
(3) R0 = R + RL

Where: R0 = Total receptor concentration

(4) L0 = L + RL

Where: L0 = Total ligand concentration

Now we have three equations (2, 3, and 4), and we can use equation (3) to substitute for RL into the other two equations. First rearrange equation 3:
(5) RL = R0 – R
And substitute this into equation 2 (6a) and equation 4 (6b):
(6a) R0 – R = K · R · L
(6b) L0 = L + R0 – R
Rearrange equation 6b to solve for L:
(7) L = L0 – R0 + R
And use equation 7 to substitute for L in equation 6a:
(8) R0 – R = K · R · (L0 – R0 + R)
Moving terms to one side:
(9) K · R · (L0 – R0 + R) + R – R0 = 0
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Which expands to:
(10) K · R · L0 – K · R · R0 + K · R2 + R – R0 = 0
and by collecting terms, yields:
(11) K · R2 + (-K · R0 + 1 + K · L0) · R – R0 = 0
This is now a quadratic equation for free antibody at equilibrium, with the form
ax2 + bx + c = 0.
Where:
a=K
b = (-K · R0 + 1 + K · L0)
c = (-R0)
So, the solution is either:
- b + b2 – 4 · a · c
2·a

or

- b – b2 – 4 · a · c
2·a

Checking both solutions, the positive root gives correct solutions, and the negative root gives physically impossible solutions. Looking at the positive
root, and filling in, we get:
(12) R = -(- K · R0 + 1 + K · L0)+ (- K · R0 + 1 + K · L0)2 - 4 · K · (- R0)
2· K
Expanding yields:
(13) R= -(-K·R0+1+K·L0) + K2·R02-2·K·R0-2·K2·R0·L0+1+2·K·L0+K2·L02-4·K·(-R0)
2·K
Which simplifies to:
(14) R = -1 · (-K·R0+1+K· L0 - K2· R02+2·K·R0-2·K2· R0· L0+1+2· L0+K2· L02)
2
K
Now, we need to get instrument signals to be related to the receptor concentration.
Assumption 3: The instrument signal is linearly related to the receptor concentration.
Given assumption 3, we can write the equation (following the form y = mx+b):
(15) Signal = Sig0 – NSB · R + NSB
R0
Where:
Signal = signal for receptor concentration (R)
Sig0 = signal at receptor concentration (R0)
NSB = signal with no receptor
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Solving equation 15 for R yields:
Signal = Sig0 – NSB · R + NSB
R0
Signal – NSB = Sig0 – NSB · R
R0
(16) R = (Signal – NSB) · R0
Sig0 - NSB
Using equation 16 to substitute for R in equation 14:
(17) (Signal-NSB) · R0 = -1 · (-K·R0+1+K·L0 - K2·R02+2·K·R0+K2·R0·L0+1+2·K·L0+K2·L02)
(Sig0-NSB) 2
K
Now, solve for signal:
(Signal – NSB) · R0 = -1 · (-K·R0+1+K·L0 - K2·R02+2·K·R0-2·K2·R0·L0+1+2·K·L0+K2·L02)
(Sig0-NSB) 2
K
(18) Signal = -(Sig0-NSB)·(-K·R0+1+K·L0 2·R0

K2·R02+2·K·R0-2·K2·R0·L0+1+2·K·L0+K2·L02) + NSB
K

Equation 18 gives the instrument signal as a function of: L0, R0, K, Sig0, and NSB

This is the basic equation used in the standard equilibrium analysis files. The data is given as signals at various L 0's. R0, K, Sig0, and NSB must be the
same for all the data points. The analysis file then finds the values for R0, K, Sig0, and NSB to minimize the squared error between the measured
signals and the calculated signals.
For the standard n-curve analysis, Sig0 and NSB are treated separately for each curve, but K is the same, and R0 maintains a fixed dilution factor
between them. Then all the data is fit to this equation, and again the parameters are found to minimize the squared error.
To summarize:
Using the following assumptions
1)
2)
3)

The binding follows the reversible binding equation for equilibrium:
kon · R · L = koff · RL
Receptor and ligand bind 1:1, such that total receptor equals complex plus free.
Instrument signal is linearly related to free receptor concentration.

Using these assumptions and some algebra, we derive the instrument signal as a function of L0, R0, K, Sig0, and NSB.
This function is then used to fit the data of signal vs. L0, to find R0, Sig0, and NSB.
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Affinity defined
Affinity is defined as:

K≡

kon
koff

[RL]__
= [R] x [L]

Where K is the equilibrium affinity, kon is the association rate constant, koff is the dissociation rate constant, [RL] is the molar concentration of
receptor-ligand complex at equilibrium, [R] is the concentration of free receptor at equilibrium, and [L] is the concentration of free ligand at
equilibrium. The KinExA instrument measures the concentration of free (uncomplexed) receptor present in a mixture of free receptor, free ligand, and
receptor-ligand complex. Once a solution of receptor and ligand have reached equilibrium, the equilibrium affinity (or its inverse, the equilibrium
dissociation) can be calculated directly from the starting concentrations and the measured concentration of free R or the ligand concentrations and
the measured concentration of free R.
One requirement for measuring affinities is that the receptor concentration be low enough that the affinity plays a role in the quantity of receptor
bound. As an extreme example, if the concentration of a monovalent receptor is 1.0 μM, the concentration of ligand is 0.5 μM, and the equilibrium
dissociation is 1.0 nM, then the concentration of free receptor at equilibrium can be calculated by solving equation (5) for a value of 0.501 μM. If the
equilibrium dissociation were 0.1 nM instead, then the free receptor would be 0.5001 μM, a change of only 2%. The problem here is that in both
cases essentially all of the ligand is being bound by the receptor and the concentration of free receptor is determined by the concentration of ligand,
rather than the affinity of the receptor-ligand interaction. A practical way to check if this is occurring is to check the percentage of bound ligand at
equilibrium.
Rate constant analysis
In measuring the rate constants, known concentrations of receptor and ligand are mixed in solution and the quantity of free receptor is repeatedly
measured as the solution phase reaction occurs. The time course of the depletion of free receptor (as it reacts with the solution phase ligand and
forms complex) is then fit with a standard bimolecular rate equation.
1. The approximate solution to the standard biomolecular rate equation for the reaction [L] + [R] ↔ [LR] is:

Signal  e –kon [L] (Time)

(19)

(20)

2. For data analysis, the exact solution to the standard bimolecular rate equation for the reaction [L] + [R] ↔ [LR] is used.
a) Letting [R] be the concentration of receptor binding sites (two times the concentration of antibody for bivalent IgG), [L] be the
concentration of ligand, kon be the forward rate constant (M-1 s-1) and koff be the reverse rate constant (s-1), the standard differential
rate equation is:

d[R*L]
dt

= (kon  [R]  [L]) – (koff  [R L])

b)Since koff=Kd * kon, we substitute Kd * kon for koff to get a differential equation with only one variable (kon), given that we know the
value of Kd .
(21)

d[R*L]
dt
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c) After measuring the concentration of R as a function of time, Equation 21 is fit to the data (using the method of least squares) with
the variables of the fit being the on rate. Alternatively, the R concentration can be measured at a fixed time as a function of ligand
concentration. Equation 21, with time held fixed and [L]0 treated as a variable, is still fit to the data to extract the rate constants. Both
of these scenarios are fully implemented in the custom KinExA Pro software.
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KinExA Limitations
The KinExA has the ability to measure affinities, dissociation constants, on-rates, and off-rates within the following parameters.
1. Affinity: 102 – 1016 M-1
a) 102 M-1 limitation: Experiments performed to determine this limitation involved cross-reactivity in an antibody-antigen system.
b) 1016 M-1 limitation: Experiments performed to determine this limitation involved an engineered antibody-antigen system.
2. Dissociation Constant (Kd): 10-2 – 10-16 M
a) 10-2 M limitation: Experiments performed to determine this limitation involved cross-reactivity in an antibody-antigen system.
b) 10-16 M limitation: Experiments performed to determine this limitation involved an engineered antibody-antigen system.
3. On-rate (kon): Greater than 103 – 109 M-1 s-1
a) 103 M-1s-1 limitation: Antibody-antigen systems having slower on-rates come to equilibrium very slowly. Keeping the system
viable, until it reaches equilibrium, becomes a problem.
b) 109 M-1 s-1 limitation: Determined by diffusion limitations1.
4. Off-rate (koff): Less than 10-6 – 100 s-1
a) 10-6 s-1 limitation: Antibody-antigen systems having slower off-rates come to equilibrium very slowly. Keeping the system viable,
until it reaches equilibrium becomes a problem.
5. Whole Cell Interactions: Please contact a Sapidyne representative to discuss whole cell limitations.
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